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Preface

The site should have the latest version installed, which is v2.9 p6.

The intended audiences for the Instructional Guide are Indian Health Service (IHS)
site managers, CACs, and iCare package managers.

The iCare system is an integrated case management system intended to provide any
IHS direct, tribal, or urban (I/T/U) healthcare providers with decision support, patient
management for single or multiple disease states, and care conditions for a single
patient or for user-defined groups of patients. iCare provides a graphical interface to
existing Resource and Patient Management System (RPMS) data, presenting different
views to include individual patient provider-defined groups, and population and
community-centric views of patient data.

The iCare application allows providers to proactively track conditions and health
statuses of their patients, any individual patient, or populations of patients, based on
specific or multiple user-defined clinical concerns. A more complex and integrated
level of logic for certain chronic conditions is defined in underlying RPMS
components and is accessible through iCare to assist non-specialist providers in
improving clinical decision-making and compliance with clinical guidelines. This
type of integrated system provides a mechanism to inform healthcare providers about
and follow up on clinical interventions and information about single or multiple
disease states and conditions.

The iCare package is intended for use by both general and specialist healthcare
providers, as well as disease-specific case managers at any I/T/U using RPMS. The
experience and skill level of all hands-on users of RPMS will range from non-expert
to expert. The providers’ knowledge of clinical guidelines and disease-specific
treatment will range from general to specialists.

The iCare system consists of two components—the RPMS KIDS and the graphical
user interface (GUI)—both of which must be installed and functioning for this
application to work.
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1.0 New User

When a new user signs on to iCare for the first time, the RPMS iCare User
Preferences set-up wizard will display. The set-up wizard will walk the user through
the minimum user preferences needed to use iCare.

Only the Define My Patients, Flag Setup, Community Alert Setup and Startup View
tabs are available during set-up.

RPMS iCare - User Preferences

Introduction]| DefineMyPatients | FlagSetwp | CommalertSetup | Stertupview |
/a AL ‘\~
;g? /%I Welcome to the RPMS iCare Preferences Setup Wizard
\% il
'O -

You are seeing this screen because it's your first login to iCare

Click Next to start.

Select an option for each of the 3 different user preferences.

oW N =

Click OK to see the iCare main screen. You will not see this Setup screen again

To change your preferences after today s login. go to Tools> User Preferences

Nesxt >

Figure 1-1: RPMS iCare Preferences Setup Wizard Introduction dialog

Click Next in the bottom right corner of the dialog to begin the setup.

1.1 Define My Patients

The first set-up criteria provides the ability to define a definition of “your” patients.
These could be patients who are assigned to a specific provider (or yourself), or it
could be based on previous patient encounters.
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RPMS iCare - User Preferences

Intrndutﬁnn/yDeﬁne My Patients r Flag Setup ]/ Comm Alert Setup r Startup View ]

Select the definition that best describes your pafient assignment NOTE: Many users do not have patients assigned to them and will choose
"Wo Provider Selected”. This will nof negatively affect your ability fo fully use the iCare application.

[ No Provider Selected
Provider Type
~| I orecp

[~ Specialty Provider FProvidar
Category:

Edit

Min & of Visits in Timeframe
[~ Primary Visit Provider

[~ Primary/Secondary Visit Provider

<« Back

Figure 1-2: Define My Patients selection

It is required to have your patients defined, but it is not required to identify a
provider. Select the No Provider Selected check box to continue to the next step. A
user can come back to modify at any time.

[ Mo Provider Selected

Figure 1-3: No Provider Selected checkbox

1. Select the provider name from the Provider drop-down menu (Figure 1-4).
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™ No Provider Selected

Provider Type

B - ooecr

POST FOUR ~ : i Frovidar

POST NINE [~ Specialty Provider Cotooryr ‘

POST.ONE

POST.SEVEN Edit

POST.SIX

POST.TEN Min # of Visits in Timeirame

ERT ™ Primary Visit Provider | _] | _I
[ Primary/Secondary Visit Pwviderl _] | _|

Figure 1-4: Provider drop-down list selection

2. After selecting the provider, identify patients who were assigned to the provider
as the DPCP (designated primary care provider), or as a specialty provider.
Specialty provider categories are defined by the Designated Provider

Management System (BDP).

™ Mo Provider Selected

Provider Type
[FOST FOUR ~| I~ brce
[¥ Specialty Provider Frovider
Categary:

s Add/Remove Provider Category

Available Seleciions

Find |

(v Starts With  Contains

Cancer A
Case Manager

Chemical Dependency

Dizbetes

HIV Case Manager

HIV Provider

Home Care

Mental Health

OB Care

Public Health Nurse

Renal Dizease

Social Services v

Add =

<= Remove

Current Seleciions

Find [

oK Cancel

Figure 1-5: Specialty Provider category selection

Additionally, patients can be identified by whether the provider had visits during
a specific timeframe and was the primary provider on the visits or was either the
primary or secondary provider on the visits.
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[ Mo Provider Selected
Provider Type
|POST.FOUR ~| I~ DPCP

[ Specialty Provider Frowder

Category:
Edit
M & of isits in Timaframe
v Primary Visit Provider |2 j |'I year j
[ Primary/Secondary Visit F'rcwider| J | J

Figure 1-6: Visit Provider selection

The Min # of Visits setting can be 1 through 9 visits. The timeframe can be 3
months, 6 months, 1 year, 18 months, 2 years or 3 years.

3. Click Next to proceed to the Flag Setup tab.

1.2 Flag Setup

Flags are special identifiers that are updated during the iCare Nightly Background
job. If your site does not have an emergency room or inpatient care, uncheck the ER
Visits, Unanticipated ER Returns, and Hospital Admissions check boxes. The
Abnormal Labs option identifies labs that are Critically Low, Low, High, or
Critically High.

See Figure 1-7 for an example of the Flag Setup tab.
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RPMS iCare - User Preferences

Introduction r Define My Patients /FlagSetupr Comm Alert Setup r Startup View ]

Flags ars identified in the background job on 3 routine basis. This screen aliows you fo select which of the fiags you would (ke fo see
displaped Electing to furmn o ane or more of the fiag displays does NOT furn off the background job for the site.

Flag Types Timeframe
[¥ Abnormal Labs ’m
v ER Visits 1 month -
[+ Unanticipated ER. Returns ,m
¥ Hospital Admissions ’m

<< Back

Figure 1-7: Flag List selection

Click Next to proceed to the Community Alerts setup tab.

1.3 Comm Alert Setup

Community alerts are conditions that can be used to identify hotspots in your
communities. They are normally CDC Nationally Notifiable Conditions. Suicidal
conditions have been added for IHS.

The first time you sign into iCare, you will see the Community Alerts pop-up
window. If you do not wish to see the community alerts when you sign in, select the
Display Community Alerts pop up window at startup? check box. You can still
access the Community Alerts tab in the iCare Main View.

/ Introdudction ]/ Define My Patients ]f Flag Setup/]/{:ommﬁlertfretup ]/ Startup View l
[] Display Community &lerts pop up window at startup?

Figure 1-8: Community Alerts at startup
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There are three tabs for community alerts: Mandatory, Recommended, and
Optional. Mandatory conditions cannot be deselected and will always be seen (the
On/Off check boxes are grayed out).

RPMS iCare - User Preferences

Introduction r Define My Patients rFIaQSEtLp/VCommAIertSQtupr Startup View l

[] Display Community Alerts pop up window at startup?

Occurrences of any 4 (o A identifiedin the backgroundjobon a e This fo 5 wihich of the € ellertsyou would likefo see displayed.
Electingfo "turn off” one afmoveofé‘w Ce thellartsin eitharthe A ledor Opiic rasdoes NOT furn oﬁ"é‘ie backgmndjob;ﬁrbﬁe sife. The G?spfayafSuxcmhfSeﬁ\awafand Mandstory Community
Alerfsmaynot be turned of

Mandatory r Recommended r Optional ]
NND & Public Health Preferences
Category | Type W | Diagnosis Y| OnfOff 7| Timeframe 7 2
: CDC NND Acanthamoeba : : s

Anthrax

Botulism, focdborne
Botulism, infant
Botulism, other
CRE

Chikungunya fever

Chaolera

Dengue

Diphtheria

Elevated Blood Lead Level
Hantavirus

Hemalytic Uremic Syndrome
Hemorrhagic fever
Legionnaires Disease
Leprosy

Listeriosis

MERS

Malaria

Measles

Melicidosis

Meningitis

Monkeypox

Mumps

Paratyphoid v

<< Back

Figure 1-9: Mandatory Community Alerts

Recommended conditions are checked by default, but you can deselect them if you do
not wish to see them (the On/Off boxes are enabled).
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I"'Iarl::lat:or\.r/l gRecommenrledEr Optional ]

NND & Public Health Preferences

Categary | Type % | Diagnosis | On/Off W | Timeframe W
RECOMMENDED { CDC NND : California Serogroup Virus D..: y

Campylobacteriosis

Eastern Equine Encephalitis...

Giardia

Hepatitis &

Histoplasmesis

Leptospirasis

Pesticide poisoning

Polie, nonparalytic

Powassan Virus Disease

Rubellz, congenital

St Louis Encephalitis Virus...

Strep Pneumaniae Drug Res..

Strep Pneumoniae Invasive

Syphilis, Primary

Taxic Shock Syndrome, Strep

Tularemia

Walley Fever

\Western Equine Encephalitis.
Public Health  Influenza

Influenza A HSN1

RSV

KA AR EEE R EEE]EEELE] R R AR

<« Back Mext ==

Figure 1-10: Recommended community alerts

Optional conditions are not checked by default, but you are able to select them if you
wish to see them (On/Off boxes are enabled).
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RPMS iCare - User Preferences

Introduction r Define My Patients rFIagSetup/CommAlertSEtupr Startup View ]

[] Display Community Alerts pop up window at startup?

Occurrences of any fit . A dentifiedin the backgroundjobon a ek This 0L £D 5 wihich of the € ey ,vwwom‘a’.n'r.»'cetoseea.’rspfayeu’
Electingfo moﬁ“mormofﬁe(? fillertsin aitherthe R fed'or Optie esabesNDTmoffﬂJe background|job for the site. The displayof Swicida/Behaviorand M it
Alertsmay not be "turned off

Mandatory r Recnmmendaﬂ/yiﬂptionali
NND & Public Health Preferences
Category W | Type Y | Diagnosis Y| On/Off V| Timeframe Y

. Eabesiosis
Brucellosis
Carbon Monoxide Poisoning
Chancroid
Chlamydia
Cryplosporidiosis
Cyclosporiasis
Ehrlichiosis
Gonorrhea
HIV
Hepatitis B, Congenital
Hepatitis B, Viral
Hepatitis C
Hepatitis C, Chronic
Lyme Disease
Meuresyphilis
Psittacosis
Silicosis
Streptococcal, invasive
Tetanus
WVISANVRSA
Vibriosis

Public Health = Haemophilus Influenzae typ...

Oooooooooooooooooooooooo

<« Back Mext ==

Figure 1-11: Optional Community Alerts

Click Next to proceed to the Startup View tab.

1.4 Startup View

Each time you sign on to iCare, the Startup View displays. The Panel List view is
selected by default; this is a view of all your panels. Meanwhile, the Split View
option allows you to display two of your iCare main views. Flag List, Community
Alerts, National Measures, IPC, and CMET are other options located on the other
tabs in the iCare Main View.

In addition, you can open a specific panel view.

User Preferences Manual New User
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RPMS iCare - User Preferences

Introduction T/ Define My Patients T/ Flag Setup T/ CommAIertSatup/VStartanew]

Selact the starfup view you would like fo see when apening iCare

+ Panel List

" Flag List

" Community Alerts
" National Measures
" IPC

" CMET

" Split View

" Panel View

Figure 1-12: Startup View selection

Originally, the default view was the split view of Panel List and Flag List.

& Split View | -]

Panel List and Flag List

" Panel View Panel List and Community Alerts
Panel List and National Measures
Panel List and CMET

Panel List and IPC

Figure 1-13: Split View selection

It is recommended you do not pick Panel View, especially if you have not created
any panels yet or if you pick a panel that has zero patients.

+ Panel View Panel Mame: | ﬂ
| |

Figure 1-14: Panel View selection

Click Finish. You are now able to start using iCare.
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| -] RPMS iCare - JONES,KAREN - 2016 DEMO HOSPITAL - F302D - 127.0.0.1 - X
File Edit View Tools Window Help Quick Patient Search: o
Panel List | Flaglist | Community Alets | NatlMeasures | CMET | TPC

JJR“

New Open Delete 9 EMAES 0

¥ ¥ Category V| #ofPts ¥ | Last Updated ¥ LostUpdatedBy ¥ Owner Vi 7 LestOpened ¥ AutoPop Flag ¥ | "Pop Started ¥ Pop Ended v

Selected Rows: 0 Visible Re

Figure 1-15: Default Panel List view
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2.0

Established User

A user can adjust their user preferences at any time. On the main view of iCare, go to
Tools -> User Preferences to update.

File Edit View

Panel List

a &

MNew Open
¥ ¥ | Categy

Tools | Window Help

Q

el i H o W@ EES

Quick Patient Search...
Reset View

Refresh

Search

Excel Export

Print

Copy Rows to Clipboard
Manage Templates

User Preferences

View iCare Motifications...

iCare Package Manager
iCare Site Parameters
Taxonomy Maintenance
Web Links

Reset User

View iCare Log

F8

F5

Ctrl+F

Ctrl+E

Ctrl+P
Ctrl+Shift+C

atd

cri

Figure 2-1: Tool menu selection

There are additional tabs for which you can set up your preferences. See Section 1.0
for examples of these tabs: Define My Patients, Flag Setup, Comm Alert Setup,
and Startup View.
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85! RPMS iCare - User Preferences — O x

DeﬁneMvPatnentsr Flag Setup r Comm Alert Setup r Startup View r’ Fatient View r’ Care MgmtGroup r Panel View r’ Layouts | CMET | IPC

Select the definition that besi descibes your paient assignment NOTE: Many users do nof have patients assigned o them and will choose
Wo Frovider Selected”. This will nof negaiively affect your abilily o fully use the iCare application.

I¥ No Provider Selected

Provider Type
~| I orcp
[~ Specialty Provider Provider
Catagory:
Edit

Min # of Visits in Timeframe
[~ Primary Visit Provider
I~ Primary/Secondary Visit Provider

cocs

Figure 2-2: User Preferences tabs

2.1 Patient View

The Patient View tab has the three clinic locations needed to do notes for letters,
telephone calls and chart reviews. These are required entries.

You can hide tabs that you do not need to see by deselecting the appropriate check
box. Additionally, you can define which tabs you want to see when going into Patient
View by selecting the appropriate starting tab. The default tab is Cover Sheet.

Note: It is recommended to leave the tabs as-is until you have
used iCare and have a better idea of how you wish to adjust
it.
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ol RPMS iCare - User Preferences — m] *

Define My Patients T/ Flag Setup r Comm Alert Setup T/ Startup V\eW/}/Patlent\ﬁewr Care Mgmt Group r Panel View r Layouts CMET [ IPC

Select the tabys) you want fo display when opening ihe iCare Fatient Record Select the defzult Locaiions io be associafed with the folfowrn
clinic codes.  These seffings must be defined in order fo creafe
View Size: &+ MNormal " Maximized Tl documenis and add chart reviews frough iCare.
Tabs

£y | Show/Hide | Starting Tab

Best Practice Prompts ] ] Followup Letter Clinic Location:
Care Mgmt ] GENERAL CLINIC -
CMET O Telephone Call Clinic Location:
Consults U TELEPHONE -
Caver Shezt Chart Review Clinic Location:
Dizgnostic Tags O

Family HX 0 0 CHART REVIEW =
Flags O O

Natl Measures [l

Notes O

Orders O

PCC ]

Problem List O

Referrals O

Reminders O

Snapshot O

Summ/Supp O O

Carce

Figure 2-3: Patient View tab

2.2 Care Mgmt Group

As more care management groups are added to iCare, the selection list will increase.
A tab has been added to user preferences so that users can identify just those groups
they are interested in using in Panel View.

The initial default will be all care management groups. Deselect the groups you are
not interested in. This list can be changed at any time in user preferences.
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85! RPMS iCare - User Preferences — O X

efine My Patiel ag Setup omm Alert Setup artup View atient View . : Care Mgmt Group anel View ayol
Define My Patients Flag Sett C Alert Set Startup Vi Patient Vi i Care Mgmt Gi ] Panel Vi Layouts CMET IPC

Salect the Care Management Groups you wan! fo see on the Care Mgmt iah of the Fatient Record

Visible Care Mgmi Groups

Register Show/Hide
Asthma

Childhood Immun

COPD

COvID

DIABETES

DM Audit

Hep C

HIV Management System
Immunizations

Pain Management
Pediatric

Prenatal

STUSTD

RERRRRRREREREE]

Care

Figure 2-4: Care Mgmt Group selection

2.3 Panel View

The Panel View tab has a similar setup to the Patient View tab, where you can hide
tabs that you do not need to see by deselecting the appropriate check boxes.
Additionally, you can define which tabs you want to see when going into Panel View
by selecting the appropriate starting tab. The default starting tab is Patient List.

Note: It is recommended to leave the tabs as is until you have
used iCare and have a better idea of how you wish to adjust
it.
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o5l RPMS iCare - User Preferences - [m} X
Define My Patients r Flag Setup r Comm Alert Setup r Startup View r Patient View r Care Mgthroup}i__lfg__n_g_l__\_{ggﬂgr Layouts CMET [ IPC
Salact the iab(s) you want fo display when opening the iCare Panel Lisw View Size: ™ MNormal " Maximized
Tabs
Show/Hide Starting Tab

Care Mgmt ||

CMET ]

Consults O

Diagnestic Tags O

Flags O

Matl Aggregated 1

Matl Measures O

Orders O

Patient List

Referrals O

Rem Aggregated O

Reminders O

Care

Figure 2-5: Panel View tab

The last three tabs, Layouts, CMET, and IPC, are advanced features in iCare. It is
recommended that you attend the iCare Office Hours if you have any questions.

24 Layouts

The Layout tab has three columns of layout templates. These templates are divided
based on the different groups (CMET, Care Mgmt, and Definition Details). When you
first access the Layouts tab, the default layout template will be selected. As you
create panels and customize your layout templates, you can identify the templates you
would like to set as your preference.

Note: It is recommended to leave the tabs as is until you have
used iCare and have a better idea of how you wish to adjust
it.
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o) RPMS iCare - User Preferences

Define My Patients r Flag Setup I/ Comm Alert Setup r Startup View r Patient View r Care Mgmt Group r Panel V\ew/yil.ayoutsg CMET | IPC

Layout
Patient List
Reminders
Natl Measures
Referrals
Consults
Orders

CMET
Events

Tracked Events

Follow-up Events

Default Template

[ Patient List Default ~|
|Remindars Default j
|Nat| Measures Default j
[Referals Defaut ~|
|Consu|ts Default j
|orders (PL) Defautt ~|
|Everrts Default j
|T|acked Events Default j
|Fn||nwup Events Default j

There zre system defEulf fampiztes for the vamous cusfomizable views fn iCare. If prefamed, you
£an choose fo creafe your own famplafes and then sef tham 3s your persanal defzults

Care Mamt Groups (CH)
Asthma |Aqlhma Default ﬂ
Childhood Immun |Ch\|dhood Immun Defautt j
COFD |cOPD Defaut =l
covip |COVID Default j
Diabetes |Diabetes Default j
DM Audit [DM Audi Defautt =l
HepC [Hep C Defautt |
HIVIAIDS |HI\-"/AIDS Defautt j
Immunizations |Immunizations Defautt ﬂ
Pain Management |Pa\n Management Default j
Pediatric |F‘ed\atnc Default j
Prenatal |Prenata| Defautt j
STUSTD |STI/STD Defauit =l

Definition Detzifs (00)
Allergies |Allergies Defautt j
Sched Appts [Appts (DD) Defait =l
CPT [cPT Defaut |
ER |E|-r|ergzanc:yr Foom Defautt j
Exams |B¢ams Defautt j
Health Factors |Heahh Factors Default j
High Risk [High Risk Defautt =l
Immunizations |Immunizations Default j
Inpatient |Inpatierrt Default j
Labs [Lab Tests Default ~|
Measurements |Measurements Default j
Medications |Med|ca1|nns Default j
Notes [Notes (DD) Defavit |
Orders | Orders (DD) Defautt |
Patient Education |Pt Education Default j
FOV [POVs Defautt |
Problems | Problem List Defaut -l
Referrals |Refenals (DD} Default j
Reminders |Remindar Notifications Defautt j
Visits | Visits (D) Defaut ~|
\Waitlists | WaitList (DD) Defaul ~|

Cancel

Figure 2-6: Layouts tab

2.5

CMET

The CMET tab is divided into two sub-tabs: Main View and Panel View. Main View
is divided into three separate tabs: Events, Tracked Events, and Follow-up Events.
Each of these tabs (Events, Tracked Events, and Follow-up Events) has a list of fields
for which you can set default filters. Additionally, you can choose to collapse Tips
and Filters displays. From the Panel View, there is only one tab for Events that is
structured the same as the tabs under Main View. From here you can designate
default filters for specific fields or you can choose to collapse Tips and Filters
displays.

Note: It is recommended to leave the tabs as is until you have

used iCare and have a better idea of how you wish to adjust

it.
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o5l RPMS iCare - User Preferences - [m| X
Define My Patients r Flag Setup r Comm Alert Setup r Startup View r Patient View r Care MgmtGroup ]/ Panel View r Layouts {1 €
Main View | Panel View ¥
Events r Tracked Events r Follow-up Events ]
The CMET Events displays all events that have been ideniified af your sife in the routine background job. Thiz can be a very large number of
evenis, but you can limit this display by aoolying any of these fifters fo your view. Filtenng in s manner does NOT affect the routine
background fob.
Category: EREAST ~ Community: Edit ~ Call Tios Display
— CERVICAL clapse lips Rspiay
COLON v " By Taxonomy Create [~ Collapse Filters Display
INFECT DIS & By Name Taxonomy
Status PENDING -
[With At Least One Patiert -
Time Frame: 3 morths - ‘
Restore to System Default
Cacs

Figure 2-7: CMET tab

2.6 IPC

The IPC tab is broken into several additional tabs: Patient Detail, Clinic Detail,
Provider Aggregated, Facility Aggregated, and Team Aggregated. These tabs
have a similar setup to the CMET tab where you able to set defaults to different fields

and collapse the Tips and Filters displays.

Note: It is recommended to leave the tabs as is until you have
used iCare and have a better idea of how you wish to adjust

1t.
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85! RPMS iCare - User Preferences - ] =

Lelect the default Measure Saffs) and Panal that you would like fo see when viewing the IPC fzbs. You may also collapse the filtars/tips.

IPC Version: |IPCMH -

Measure Set: [=-  Core
i+ [#] Chrenic Care

™ Collapse Tips Display
[~ Collapse Filters Display

i

Figure 2-8: IPC tab
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Acronym List

Acronym | Meaning

AG Patient Registration Namespace

AICD IHS ICD/CPT Lookup & Grouper

AMQQ Q-Man Namespace

APCD PCC Data Entry Namespace

APCH PCC Health Summary Namespace

ATX Taxonomy Namespace

BAT IHS Asthma Register Namespace

BDM Diabetes Management System Namespace
BGP IHS Clinical Reporting Namespace

Bl Immunization Namespace

BJPC IHS PCC Suite Namespace

BKM HIV Management System Namespace
BMC Referred Care Info System Namespace
BMX BMXNet

BQl iCare Namespace

BUSA IHS User Security Audit Namespace
CMET Care Management Event Tracking

DI VA FileMan

DSPM DESIGNATED PROVIDER MGT SYSTEM
DX Diagnosis Tags

GUI Graphical User Interface

HIV Human Immunodeficiency Virus

HMS HIV Management System

IHS Indian Health Service

IPC Improving Patient Care Collaborative
KIDS Kernel Installation and Distribution System
oIT Office of Information and Technology

0Ss Operating System

PC Personal Computer

PCC RPMS Patient Care Component

PCMH Patient Centered Medical Home

PIMS Patient Information Management System
RPMS Resource and Patient Management System
SMS Microsoft Systems Management Server
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Acronym | Meaning
XB IHS/VA Utilities Namespace
XU VA Kernel Namespace
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Contact Information

If you have any questions or comments regarding this distribution, please contact the
OIT Help Desk (IHS).

Phone: (888) 830-7280 (toll free)
Web: https://www.ihs.gov/itsupport/

Email: itsupport@ihs.gov
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